Session Two: Doing Useful Work with Excel

Only those who have the patience to do simple things perfectly ever acquire the skill to do difficult things easily.

Unknown author

Now that you’ve mastered the basics you are ready to do really useful work with this amazing tool. In this session you will learn to use all of Excel’s basic features properly. This will put you way ahead of anybody that hasn’t been formally trained in Excel best practice. You’ll be doing simple things, but you’ll be doing them perfectly!

Even after years of daily use many users are unable to properly use Excel’s fundamental features. They often reach their goal, but get there in a very inefficient way simply because they were never taught how to do things correctly. By the end of this session you’ll be astonished with how well you are working with Excel. What originally seemed like a baffling array of little colored buttons will suddenly all begin to make sense.

Session Objectives

By the end of this session you will be able to:

- Enter text and numbers into a worksheet
- Create a new workbook and view two workbooks at the same time
- Use AutoSum to quickly calculate totals
- Select a range of cells and understand Smart Tags
- Enter data into a range and copy data across a range
- Select adjacent and non-adjacent rows and columns
- Select non-contiguous cell ranges and view summary information
- Re-size rows and columns
- AutoSelect a range of cells
- Use AutoSum to sum a non-contiguous range
- Use AutoSum to quickly calculate averages
- Create your own formulas
- Create functions using Formula AutoComplete
- Use AutoFill for text and numeric series
- Use AutoFill to adjust formulas
- Use AutoFill Options
- Speed up your AutoFills and create a custom fill series
- Use the zoom control
- Print out a worksheet
Lesson 2-1: Enter text and numbers into a worksheet

Excel beginners tend to reach for the mouse far too often. One of the keys to productivity with Excel is to avoid using the mouse when entering data. In this lesson we’ll quickly populate a worksheet without using the mouse at all.

1 Open the Sample file: First Quarter Sales and Profit.

2 Notice the difference between values and text.

Cells can contain values or text. Values can be numbers, dates or formulas (more on formulas later).

Excel usually does a great job of recognizing when there are values in a cell and when there is text. The giveaway is that text is always (by default) left aligned in the cell and values are right aligned.

Look at the numbers on this worksheet. Notice how they are all right aligned. This lets you know that Excel has correctly recognized them as values and will happily perform mathematical operations using them.

3 Save a value into a cell.

1. Type the value 42000 into cell B5. Notice that the mouse cursor is still flashing in the cell.

At this stage the value has not been saved into the cell.

If you change your mind, you can still undo the value by pressing the <ESC> key at the top left of your keyboard or by clicking the Cancel button on the left hand side of the Formula Bar.

2. Decide that you want to keep this value in the cell by either pressing the <Enter>, <Tab> or an <Arrow> key on the keyboard, or by clicking the Confirm button on the Formula Bar.

4 Enter a column of data without using the mouse.

When you enter data into a column there’s no need to use the mouse. Press the <Enter> key after each entry and the active cell moves to the cell beneath. Try this now with the following January sales data:

### Entering numbers as text

Sometimes you need Excel to recognize a number as text.

If you type an apostrophe (’) first, Excel won’t display the apostrophe but will format the cell as text. You’ll notice that the number is then left justified to reflect this.

When a number is formatted as text you cannot perform any mathematical calculation with it.
1. Type 18,000 into cell B6.
2. Press the <Enter> key to move to cell B7.
3. Do the same to enter the relevant values into the next two cells.

5. Enter a row of data without using the mouse.

When you enter a row of data you also don’t have to use the mouse.

1. Click in Cell C5.
2. Type 39,000 and then press the <Tab> key on your keyboard.
   - The <Tab> key is on the left hand side of the keyboard above the <Caps Lock> key. Notice how pressing the <Tab> key saves the value into the cell and then moves one cell to the right.
3. Type 43,000 in cell D5 and press the <Enter> key.
   - You magically move to cell C6 as Excel assumes you want to begin entering the next row.

6. Complete the table without using the mouse.

By using the <Tab> or <Enter> key in the right place you should be able to complete the table now without using the mouse:

7. Change the text in cell B3 to January.

1. Double-click cell B3. Notice that there is now a flashing cursor in the cell.
2. Type January on the keyboard to change Jan to January.
3. Press the <Enter> key.

8. Change the text in cell B3 back to Jan using the formula bar.

Click once in cell B3 and then change the text in the formula bar back to Jan (see sidebar).

9. Save your work as First Quarter Sales and Profit-2.
Lesson 2-2: Create a new workbook and view two workbooks at the same time

1. Create a new workbook by opening Excel

   The easiest way to create a new workbook is to simply open Excel. Excel helpfully creates a workbook, unimaginatively named Book1. If you already have a workbook open called Book1, the new workbook will be called Book2... and so on.

   Open Excel now and see this in action. Notice that Book1 – Microsoft Excel is displayed on the Title Bar.

2. Create another new workbook.

   You wouldn’t want to have to open and close Excel every time you needed a new workbook.

   1. Click the File button at the top left of the screen and click the New button in the left hand menu.

      The New Workbook window is displayed in Backstage view:

      2. Double-Click the Blank workbook template. A new blank workbook called Book2 is displayed in the workbook window.

         You could be forgiven for thinking that nothing has happened but you can see that the Title Bar now says: Book2 – Microsoft Excel, showing that you are now looking at a different workbook.

---

**Note**

**What are templates?**

The vast majority of users know nothing about templates and simply base every worksheet upon the Blank Workbook default template supplied by Microsoft.

The Blank Workbook template has no information in the worksheet itself, but contains all of the Excel Option settings such as the default font size and type.

Templates can also contain anything that a worksheet can contain and are used to store worksheet frameworks to give you a flying start when you find that you often create very similar worksheet layouts.

If you explore the New Workbook dialog a little more you’ll see that there are hundreds of pre-built templates provided by Microsoft.

Later in this course, in: Lesson 3-14: Create a template you’ll learn how to create your own template library to personalize the appearance of your workbooks.

---

**Tip**

Other ways of creating a new workbook

- Use the keyboard shortcut <Ctrl>+<N>.
- Add a button to the Quick Access Toolbar.

See more details of how this is done in: Lesson 3-13: Customize the Quick Access Toolbar and preview the printout.
See the What are templates sidebar for more information about templates.

3 Use the taskbar to move between workbooks.

You’ll see an Excel icon with two right-hand borders at the bottom of the screen. Hover over this icon with your mouse. A menu will pop up showing two workbooks: Book1 and Book2.

Click on each item in the pop-up menu to show each workbook in the worksheet window. The only difference you will see is the Title Bar changing from Book1 to Book2 because both workbooks are empty.

See the sidebar for other methods of switching windows.

4 Show both Book1 and Book2 in the worksheet window at the same time.

This skill often draws a gasp of amazement from my students. Believe it or not, most Excel users don’t know how to do this.

1. Click View ➔ Window ➔ Arrange All.

   The Arrange Windows dialog is displayed.

2. Choose the Horizontal arrangement and click the OK button.

Both workbooks are now shown within the workbook window:

Notice that as you click each workbook window the title bar lights up and the Close/Minimize/Restore Down buttons appear, to show that this is the active workbook.

5 Close Book2 and maximize Book1 to restore the display to a single workbook.

If you’ve forgotten how to do this, refer back to: Lesson 1-3: Understand the Application and Workbook windows.
Lesson 2-3: Use AutoSum to quickly calculate totals

Excel’s AutoSum feature is a really useful and fast way to add the values in a range of cells together.

1. Open First Quarter Sales and Profit-2 from your sample files folder (if it isn’t already open).

2. In cell A9 Type the word Total followed by the <Tab> key.

   The cursor moves to the right and is now in cell B9:

   ![Excel cells with numbers and AutoSum button](image)

3. Click: Home→Editing→∑ (this is the AutoSum button).

   Something interesting has happened to the worksheet:

   ![Excel marquee and AutoSum formula](image)

Excel has placed a marquee around the number range that AutoSum has guessed we want to work with. The pattern of dots that marks the boundary of the marquee is called the marching ants (that really is the technical term for them)!

The marching ants surround all of the numbers in the column above, up to the first blank cell or text cell (in this case, up to the word Jan).

=SUM(B4:B8) is your first glimpse of an Excel Formula. Formulas always begin with an equals sign. This formula is using the SUM function to compute the Sum (or total) of the values in cells B4 to B8.

anecdote

I ran an Excel course for a small company in London a couple of years ago.

The boss had sent his two office staff to learn a little more about Excel.

Before the course began I asked the delegates how long they had been using Excel. They told me that they’d been using it for two years to do all of their office reports.

When I showed them AutoSum they gasped in delight. “This will save us hours” they told me.

I was curious how they had been doing their reports before.

Believe it or not, they had been adding up all of the figures in each column with a calculator and then manually typed the totals at the bottom of each column.

In this case the boss had given them Excel as he had heard it was very good. Unfortunately he had not initially seen the need to train the staff in its use.

With no training it seemed quite logical to them to use it like a word processor and the boss had still been delighted that his staff were using such impressive technology.
4. Press the <Enter> key or click the AutoSum button \(\sum\) once more to display the total January sales:

5. Type the word **Total** in cell E3 and press the <Enter> key once.

The cursor moves down one row and is now in cell E4.

6. Use AutoSum to calculate sales for New York.

   1. Click Home→Editing→AutoSum. \(\sum\)

      This time AutoSum correctly guesses that you want to sum the values to the left of cell E4:

      2. Press the <Enter> key, or click the AutoSum button once more.

7. Save your work as **First Quarter Sales and Profit-3.**
Lesson 2-4: Select a range of cells and understand Smart Tags

Sometimes you don’t want to add all of the values in a column. You only want to add a selection of cells that you define yourself. This lesson shows you how to do this with a different AutoSum technique.

1. Open First Quarter Sales and Profit-3 from your sample files folder (if it isn’t already open).

2. Observe the formula behind the value in cell B9.
   Click on cell B9 or move to it with the arrow keys on your keyboard.
   Look at the formula bar at the top of the screen. Notice that the cell displays the value of a calculation and the formula bar shows the formula used to calculate the value:

   ![Formula bar example]

3. Delete the contents of cell B9.
   The easiest way to delete the contents of a cell is to press the <Delete> key on your keyboard but you can also right-click the cell and then click Clear Contents from the shortcut menu.

4. Change the word Total in cell A9 to USA Sales and press the <Tab> key once.
   You don’t have to delete the word Total before typing USA Sales. When you click once in a cell (be careful not to double-click) and immediately begin to type, the existing cell contents are replaced.
   The cursor moves to cell B9.

5. Select cells B4:B5 with your mouse.
   When the mouse cursor hovers over a cell there are three possible cursor shapes:
Session Two: Doing Useful Work with Excel

**note**

**Selecting cells with the keyboard**

To select cells with the keyboard, hold down the `<Shift>` key and then use the `<Arrow>` keys to select the range needed.

**note**

**Selecting a large range of cells with the `<Shift>`-click technique**

If you need to select a very large range of cells, it is sometimes useful to use this technique:

1. Click the cell in the top left corner of the required range.
2. If necessary, use the scroll bars to make the bottom right corner of the required range visible.
3. Hold down the `<Shift>` key.
4. Click in the bottom right corner of the required range.

---

<table>
<thead>
<tr>
<th>Cursor</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="cursor.png" alt="Select Cursor" /></td>
<td>The white cross (Select) cursor appears when you hover over the center of the active cell. You can then click and drag to select a range of cells.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="AutoFill Cursor" /></td>
<td>The black cross (AutoFill) cursor appears when you hover over the bottom right-hand corner of the active cell. We’ll be covering AutoFill later in this session.</td>
</tr>
<tr>
<td><img src="cursor.png" alt="Move Cursor" /></td>
<td>The four headed arrow (Move) cursor appears when you hover over one of the black edges of the cell (but not the bottom right corner).</td>
</tr>
</tbody>
</table>

Beginners often have difficulty selecting cells and end up moving them or AutoFilling them by mistake.

Position the mouse at the center of cell B4 so that you see the White Cross (select) cursor. When you see the white cross, hold down the left mouse button and drag down to cell B5. You have now selected cells B4 and B5 (in Excel speak we say that you have selected the range B4:B5).

1. Click the AutoSum button: Σ

USA sales are shown in cell B9. Notice the small green triangle at the top left of B9. This is Excel’s way of saying: “I think you may have made a mistake”.

Select cell B9 and you will see an Exclamation Mark icon. This is called a Smart Tag.

2. Hover the mouse cursor over the Smart Tag.

A tip box pops up telling you what Excel thinks you may have done wrong (see below). Of course, in this case, everything is fine. The Smart Tag thinks that perhaps we didn’t want just the USA sales – but the Smart Tag is mistaken!

3. Examine the remedial actions suggested by the Smart Tag.

Click the drop-down arrow next to the exclamation mark icon. A list of possible remedial actions is displayed. In this case you can choose Ignore Error to remove the green triangle from the corner of the cell.

4. Save your work as First Quarter Sales and Profit-4.
Lesson 2-5: Enter data into a range and copy data across a range

Now that you have mastered the technique of selecting cells, you can use it to speed up data entry.

When you select a range of cells prior to entering data, Excel knows that all data entered belongs in that range. Several key combinations are then available to greatly speed up data entry.

1. Open a new workbook and save it as Data Range Test.

3. **Type London.**
   The text appears in Cell B2, the top left cell in the range selected.
4. **Press the <Enter> Key.**
   The cursor moves to cell B3 as it normally would.
5. **Type Paris followed by the <Enter> key.**
   The cursor moves to cell B4 as it normally would.
6. **Type New York followed by the <Enter> key.**
   This time something new happens. The cursor doesn’t move to cell B5 as you might expect but jumps to cell C2.
7. **Type 150,000 followed by the <Enter> key.**
   The value appears in C2 and Excel moves down the column again to cell C3.
8 Press the <Enter> key without entering a value to leave C3 blank.
   Excel moves down the column to cell C4.

9 Type 225,000 followed by the <Enter> key.
   The cursor jumps to cell D2.

10 Press <Shift>+<Enter> twice to change your mind about leaving Paris blank.
   1. Press <Shift>+<Enter> to move backwards to New York sales.
   2. Press <Shift>+<Enter> a second time and you are back to the Paris cell.

11 Type 180,000 followed by the <Tab> key.
   <Tab> moves you across the range, to cell D3.

You can now appreciate how to use this technique of <Enter>, <Tab>, <Shift>+<Tab> and <Shift>+<Enter> to save a lot of time when entering a whole table of data.

12 Select cells D2:D4.

13 Type 50% but don’t press the <Enter> or <Tab> keys.
   The challenge this time is to place the same value into cells D3 and D4 without having to type the value two more times.

14 Press <Ctrl>+<Enter>.
   The value is replicated into all of the other cells in the range.
Lesson 2-6: Select adjacent and non-adjacent rows and columns

1. Open *First Quarter Sales and Profit-4* from your sample files folder (if it isn’t already open).

2. Select all of column A.

   Hover the mouse cursor over the letter A at the top of the column. The button lights up and the mouse cursor changes to a black down arrow:

   ![Column A selection](image)

   Click to select the entire column. The column becomes slightly shaded and a black line surrounds all of the cells.

3. Click: Home→Font→Bold to bold face the column.

   Because the whole column was selected, all of the values become bold faced.

4. Click: Home→Font→Bold once more to change the type in column A back to normal.

5. Select all of row 4.

   To select a row, hover the mouse cursor over the number on the left hand side of the row. The button lights up and the mouse cursor changes to a black arrow pointing across the row:

   ![Row 4 selection](image)

   Click to select the row.

6. Select columns B and C.

   Hover over the letter at the top of column B until you see the black down arrow. When you see the arrow, click and drag to the right to select both columns.
7 Select rows 6 and 7.
Hover over the number at the left of row 6 until you see the black arrow pointing across the row. When you see the arrow, click and drag down to row 7 to select both rows.

8 Select columns A, B, C, D and E.
Sometimes you will need to select a large number of adjacent columns or rows. You could drag across them but it is often easier to use the following technique:
1. Select Column A.
2. Hold down the <Shift> key.
3. Select Column E.
Columns A to E are selected.

9 Select rows 4 and 6.
Perhaps you need to perform an operation on two non-adjacent rows. To select rows 4 and 6 you need to:
1. Select row 4.
2. Hold down the <Ctrl> key on the keyboard.
Lesson 2-7: Select non-contiguous cell ranges and view summary information

Non-contiguous is a very impressive word! It simply means a range of cells that is split across two blocks of cells in different parts of the worksheet.

Non-contiguous ranges can be selected using both the mouse and keyboard. The keyboard method may seem a little involved at first but you’ll find it much faster once you have the hang of it.

1 Open First Quarter Sales and Profit-4 from your sample files folder (if it isn’t already open).

2 Select the contiguous range B4:D8 with the keyboard.

When you need to select a contiguous range with the keyboard here’s how it’s done:

1. Use the arrow keys on the keyboard to navigate to cell B4.
2. Hold down the <Shift> key on the keyboard
3. Still holding the <Shift> key down, use the arrow keys on the keyboard to navigate to cell D8

The contiguous range B4:D8 is selected.

3 Select the non-contiguous range B4:B8,D4:D8 using the mouse.

1. Select the range B4:B8.
2. Hold down the <Ctrl> key and select the range D4:D8.

The non-contiguous range B4:B8,D4:D8 is selected:
4 Select the same non-contiguous range with the keyboard.
This is a little more involved than using the simple
\(<\text{Shift}>+<\text{Arrow keys}>\) method used earlier.
Here’s how it’s done:
1. Use the arrow keys on the keyboard to navigate to cell B4
2. Press the \(<F8>\) key (it is on the very top row of your keyboard)
3. Use the arrow keys to navigate to cell B8
4. Press \(<\text{Shift}>+<F8>\)
5. Use the arrow keys to navigate to cell D4
6. Press \(<F8>\)
7. Use the arrow keys to navigate to cell D8
8. Press \(<\text{Shift}>+<F8>\) one last time
The non-contiguous range B4:B8,D4:D8 is selected:

5 Obtain a total sales figures for January and March using the
status bar.
The status bar contains summary information for the currently
selected range.
Look at the bottom right of your screen. You can see the average
sales and total sales (sum of sales) for January and March:

6 View the Maximum and Minimum sales for January and
March using the status bar.
Right-click the status bar and click Maximum and Minimum on the
pop-up menu (see sidebar).
The status bar now also displays Maximum and Minimum values.

7 Close the workbook without saving.
Lesson 2-8: AutoSelect a range of cells

When data is arranged in a block (as it is in the Sales and Profit Report) it is referred to as a **Range** (in early versions of Excel it used to be called a database or list).

You will often want to select a row or column of cells within a range, or even the entire range.

You can select ranges by using any of the techniques covered so far but this could be very time consuming if the range encompassed thousands of rows and columns.

In this lesson you’ll learn how to select range rows, range columns and entire ranges with a few clicks of the mouse.

1. **Open Sales Report** from your sample files folder.
   
   This report contains a range of cells. The range is the block of cells from A3 to E19.

2. **Select all cells within the range to the right of cell A7.**
   
   1. Click in cell A7 to make it the active cell.
   2. Hover over the right hand border of cell A7 until you see the four headed arrow cursor shape.
   3. When you see this cursor shape hold down the `<Shift>` key and double-click.
   
   All cells to the right of A7, but within the range, are selected.
3 Select all cells within the range except the header row.

1. Click in cell A4 to make it the active cell.
2. Hover over the right hand border of cell A4 until you see the four headed arrow cursor shape.
3. When you see this cursor shape hold down the <Shift> key and double-click.
   All cells to the right of cell A4, but within the range, are selected.
4. Hover over the bottom border of the selected range until you see the four headed arrow cursor shape.
5. When you see this cursor shape hold down the <Shift> key and double-click.
   The entire range (except the header row) is selected.

You can also use this technique to select cells to the left of the active cell or above the active cell.

4 Close the workbook without saving.
Lesson 2-9: Re-size rows and columns

1. Open *First Quarter Sales and Profit-4* from your sample files folder (if it isn’t already open).

Notice that columns B, C, D and E are far too wide for their contents. It would be useful to make them narrower to keep the worksheet compact.

2. Re-size column B so that it is just wide enough to contain the January sales figures.

Hover over the line separating the letters B and C until you see the re-size cursor shape:

When you see this shape, keep the mouse still and click and drag to the left. Column B will re-size as you drag. Make it narrower so that the values just fit in the column. Notice that the column width in points and pixels are displayed as you drag (one point = 1/72 inch).

3. Re-size column B so that it is too narrow to contain the January sales figures.

Notice that when the column isn’t wide enough to contain the contents, hash signs are shown instead of values (if you’re used to hashes being called *pound signs* or *number signs* see the sidebar).

4. Automatically re-size column B so that it is a perfect fit for the widest cell in the column.

Hover over the line separating the letters B and C until you see the re-size cursor shape:

When you see this shape, double-click to automatically re-size column B.

---

**note**

Why are you calling the pound sign a hash?

You like potato and I like poatahto, You like tomato and I like tomahto; Potato, poatahto, tomato, tomahto! Let’s call the whole thing off!

*Song lyric by George Gershwin, American Composer (1898-1937)*

In the USA and Canada the hash symbol is called the *pound sign* or the *number sign*.

In different USA/Canada regions the single symbol has different names because it can be used to denote a number (as in contestant #5) or as a weight (as in 3# of butter).

Throughout this book I will refer to the # as a hash because that is the term used in most other English speaking countries.
5. Automatically re-size every column in the worksheet in one operation.
   1. Select every cell in the workbook by clicking the select all button in the top left corner of the worksheet (you can also do this by clicking in any blank cell and then pressing <Ctrl>+<A>).
   2. Hover over the intersection of any two columns until you see the re-size cursor shape and then double-click.

Every column is now perfectly sized.

Notice that Auto-resize has done its job rather too well. Column A is now wide enough to accommodate all of the text in cell A1.

6. Automatically re-size column A so that it is only wide enough to contain the longest city name (Los Angeles).
   2. Click: Home→Cells→Format→AutoFit Column Width.

This time the column is automatically sized so that it is wide enough to contain all of the text in the selected cells.

Notice that the text has spilled over from cell A1 into the adjoining columns B, C, D and E. This always happens when a cell contains text and the adjacent cells are empty.

7. Manually size row 3 so that it is about twice as tall as the other rows.

Do this in exactly the same way you re-sized the column but, this time, hover between the intersection of rows 3 and 4 until you see the re-size cursor shape, and then click and drag downwards.

8. Auto-resize row 3 so that it is the same size as the other rows again.
Lesson 2-10: Use AutoSum to sum a non-contiguous range

In: Lesson 2-7: Select non-contiguous cell ranges and view summary information, you learned how to view the sum of January and March sales using the status bar. But how can you put that value onto the worksheet?

Now that you have the hang of selecting non-contiguous ranges you can use this in conjunction with your AutoSum skills to create a formula that will calculate the total of a non-contiguous range.

1. Open First Quarter Sales and Profit-4 from your sample files folder (if it isn’t already open).
2. Enter the text Jan/Mar Sales in cell A10 and press the <Tab> key.

The active cell moves to cell B10.
3. Re-size column A so that it is wide enough to contain the text.
   1. Hover over the line separating the letters A and B until you see the re-size cursor shape:
   2. When you see this shape, keep the mouse still and click and drag to the right. Column A will re-size as you drag. Make it wider so that the words Jan/Mar Sales comfortably fit in the column:

4. Click Home → Editing → Σ (the AutoSum button).

An AutoSum appears in cell B10 but it isn’t anything like what we want yet. It guesses that we simply want to repeat the value in the USA Sales cell.

5. Select the range B4:B8 with the mouse.
6 Hold down the <Ctrl> key and select the range D4:D8 with the mouse.

Notice that the non-contiguous range B4:B8,D4:D8 is shown in the AutoSum’s formula:

7 Press the <Enter> key or click the AutoSum button ∑ again to view the sales for January and March in cell B10.

8 Save your work as First Quarter Sales and Profit-5.
Lesson 2-11: Use AutoSum to quickly calculate averages

Excel’s AutoSum feature isn’t only restricted to addition. It is also able to compute averages and maximum/minimum values.

In this lesson we’ll use AutoSum to calculate the average sales for each month.

1. Open First Quarter Sales and Profit 5 from your sample files folder (If it isn’t already open).
   Select cells E3 and E4 and press the <Delete> key on your keyboard.
3. Type the word Average in cell E3 and press the <Enter> key.
   The cursor moves to cell E4:
4. Use AutoSum to create a formula that will show the Average New York sales.
   1. Click: Home ➔ Editing ➔ AutoSum ➔ Drop down arrow (see sidebar).
   A drop down menu is displayed showing all of the different ways in which AutoSum can operate upon a range of cells:
   2. Click Average.
   3. Excel generates an Average function and inserts the cell range B4:D4. This is exactly what we want:
5. Type the word Maximum in Cell F3 and then press the <Enter> key.
6. Use AutoSum to create a formula in cell F4 that will show the Maximum New York Sales for this period.
1. Place an AutoSum in cell F4 but this time, choose Max from the drop-down menu.

This time we have a small problem. AutoSum is including the average value (23,333) in the calculation.

![Table showing AutoSum calculations]

2. Select cells B4:D4 with the mouse.

The marquee corrects and the average value in cell E4 is no longer included.

![Table showing Max function]

Notice that the Max function is now working with the range B4:D4.

3. Press the **<Enter>** key or click the AutoSum button once more to see the maximum sales the New York office managed during the first quarter of the year:

![Table showing maximum sales]

7. Change the words *USA Sales* in cell A9 back to *Sales* and press the **<Tab>** key.

8. Press the **<F2>** key on the keyboard (or double-click cell B9) to bring back the marquee (shown as a blue box).

9. Adjust the marquee using click and drag so that all offices are included in the Sales total.

Notice that there is a small blue spot on each corner of the range. These are called sizing handles.

1. Hover the mouse cursor over the bottom right (or bottom left) sizing handle until the cursor shape changes to a double headed arrow. It is really important that you see the double headed arrow and not the four headed arrow or white cross.

![Sizing handles]

2. When you see the double headed arrow click and drag with the mouse down to cell B8.

3. Release the mouse button.

4. Press the **<Enter>** key or click the AutoSum button again.

10. Save your work as *First Quarter Sales and Profit-6*.
Lesson 2-12: Create your own formulas

The AutoSum tool is very useful for quickly inserting Sum(), Average(), Count(), Max() and Min() formulas into cells. Many Excel users never get any further with their formulas than this.

In this session we’ll create our own formulas without the use of AutoSum. You’ll be amazed at how easy it is.

1. Open First Quarter Sales and Profit-6 from your sample files folder (if it isn’t already open).

2. Select cells A10:B10 and press the <Delete> key once.

   The previous contents of cells A10:B10 are removed.

3. Type the word Costs into cell A11 and Profit into cell A12.

4. Type the value 83,000 into cell B11 and press the <Enter> key to move down to cell B12.

5. Enter a formula into cell B12 to compute the profit made in January.

   1. Type: =B9-B11 into cell B12.

   2. Press the <Enter> key.

   The profit for January is displayed:

   ![Profit for January](image)

6. Enter the formula again using a better technique.

   The method that you have just used to enter the formula works just fine but it isn’t the best method. Sooner or later you will make a mistake. For example you could easily type=B8-B11 resulting in an incorrect answer.

   To eliminate such errors you should always select cell references visually rather than simply type them in. You can visually select cells using either the mouse or the keyboard. First we’ll use the mouse method.

   1. Click in cell B12 and press the <Delete> key on the keyboard to clear the old formula.

   2. Press the equals ⇩ key on the keyboard.

   3. Click once on the value 129,000 in cell B9.
4. Press the minus − key on the keyboard.
5. Click once on the value 83,000 in cell B11.
6. Press the <Enter> key on the keyboard.

If you followed the above steps carefully you will see that you have created the same formula but with a much lower possibility of making a mistake.

7 Enter the formula again using the visual keyboard technique.

The very best Excel experts hardly use the mouse at all. You waste valuable seconds every time you reach for the mouse.

Here’s the expert technique of visual selection via keyboard:
1. Use the arrow keys to navigate to cell B12 and then press the <Delete> key on the keyboard to clear the old formula.
2. Press the ⇧ key on the keyboard.
3. Press the <Up Arrow> key three times to move to cell B9.
4. Press the ⇧ key on the keyboard.
5. Press the <Up Arrow> key once to move to cell B11.
6. Press the <Enter> key on the keyboard.

8 Enter a formula that uses the multiplication operator.

This employer is very generous and pays the staff ten percent of all profits as an incentive bonus.

In cell A13 type the words 10% Bonus and then press the <Tab> key on the keyboard to move to cell B13.

9 Enter a formula that uses the multiplication operator.

The multiplication operator is not an X as you might expect but an asterisk (*). The other Excel operators are shown in the sidebar.

You need to press <Shift>+8 to enter an asterisk. If you are using a full size keyboard with a numeric keypad at the right-hand side you can also use the numeric keypad’s <X> key.

Whichever key you use you’ll still see an asterisk in the formula.

Use either the mouse click technique or the visual keyboard technique to enter the formula shown below into cell B13 and then press the <Enter> key to see how much bonus was earned:

10 Save your work as First Quarter Sales and Profit-7.
Lesson 2-13: Create functions using Formula AutoComplete

1. Open First Quarter Sales and Profit-7 from your sample files folder (if it isn’t already open).

2. Type the words USA Sales into cell A15 and European Sales into cell A16.

   Notice that the text European Sales spills over into column B because column A isn’t wide enough to contain it.

3. Re-size column A so that it is wide enough for the words European Sales to fit within the column.

   You learned how to do this in: Lesson 2-9: Re-size rows and columns.

4. Click into cell B15 and type =S into the cell.

   Something amazing happens:

   A list drops down showing every function in the Excel function library beginning with S. This feature was introduced in Excel 2007 and is called Formula AutoComplete (if AutoComplete didn’t display as expected see the sidebar).

   You’ve already encountered the Sum(), Average() and Max() functions courtesy of AutoSum.

   You may be pleased (or dismayed) to know that there are over 300 functions in the Excel function library. The good news is that most untrained Excel users only ever get to understand Sum() and Average()!

   When you typed =S Excel listed all functions beginning with S.

5. Continue typing: =SU.

   Notice that the list now only shows functions beginning with SU and look… there’s the SUM() function we need three down in the list.

   You could simply click on it with the mouse but let’s behave like an Excel pro and do it with the keyboard.

6. Press the <Down Arrow> key twice to move the cursor over the SUM function.

   The Sum function now has a tip telling you what the function does:
Display detailed information about the SUM() function.

The tip tells you a little about the SUM() function but to get the full story press the <F1> key while SUM is still highlighted in the dropdown list:

The Excel help system opens showing detailed help for the SUM() function.

Read the help text if you are interested and then close the help window.

Notice that Excel has now left you with only =SU in the cell. Complete the formula by typing M(

Notice that a little box has appeared beneath the function call. This is the Syntax (see sidebar for more information).

Select the cells that you need to sum (cells B4:B5) with the mouse or keyboard.

If you want to be a real pro you should select them with the keyboard. To do this:
1. Press the <Up Arrow> key repeatedly until you reach cell B4.
2. Hold down the <Shift> key and press the <Down Arrow> key once to select cells B4:B5.

Type a closing bracket to complete the formula and then press the <Enter> key.

The total USA sales are displayed in cell B15.

Use the same technique to create a SUM() function in cell B16 to show the total European sales (cells B6:B8).
1. Click in cell B16.
2. Type =SU.
3. Press the <Down Arrow> key twice to move the cursor over the SUM function.
4. Press the <Tab> key to automatically enter the SUM function into cell B16.
5. Select the range B6:B8.
6. Type the closing bracket followed by the <Enter> key. The formula should now be: =SUM(B6:B8).

Save your work as First Quarter Sales and Profit 8.
Lesson 2-14: Use AutoFill for text and numeric series

1. Open *First Quarter Sales and Profit-8* from your sample files folder (if it isn’t already open).

2. Delete the text *Feb* and *Mar* from cells C3:D3.
   Select cells C3:D3 and then press the <Delete> key on your keyboard.

3. Make B3 the active cell.
   Notice that there is a black border around the cell and a black spot on the bottom right-hand corner. This is the AutoFill handle. If you don’t see it, refer to the sidebar.

4. Hover over the AutoFill handle with your mouse until the cursor shape changes to a black cross.
   Many of my students have great difficulty with this when they try it for the first time.
   - You don’t want the four-headed arrow:  – that would move the cell.
   - You don’t want the white cross:  – that would select the cell.
   - You want the black cross:  – the AutoFill cursor.

5. When the black cross cursor is visible, hold down the mouse button and drag your mouse to the right to AutoFill the other months: *Feb* and *Mar*.
   Notice the tip that appears as you drag, previewing the month that will appear in each cell.

6. In cell A18 type *Monday* and AutoFill down to cell A24 to show the days of the week.
   (If you are not using an English language version of Excel you will need to type *Monday* in your own language).

7. In cell B18 type the number 1 and in cell B19 type the number 2.
8 Select cells B18 and B19.

9 AutoFill down to B24 to create sequential numbers:

10 In cell C18 type 9 and in cell C19 type 18.

11 Select cells C18 and C19.

12 AutoFill down to B24 to create the nine times table.

13 Use AutoFill to create sequential dates.
   1. Type 01-Jan-08 into cell D18.
   2. Type 02-Jan-08 into cell D19.
   4. AutoFill down to D24 to create sequential dates.

14 Use AutoFill to quickly copy values.
   Sometimes you will want to duplicate the value from one cell into many others to the right of, left of, beneath, or above the active cell.
   When a cell containing text is the active cell and it isn’t defined as a fill series (the built-in fill series are days of the week and months of the year), AutoFill will simply duplicate the contents of the cell:
   Type the text Adjusted into cell E18 and then AutoFill it down as far as cell E24.
   The same text is now shown in each of the cells:

15 Save your work as First Quarter Sales and Profit-9.
Lesson 2-15: Use AutoFill to adjust formulas

AutoFill can save you a lot of time when extending or copying text and number ranges. But the story’s not over yet.

AutoFill’s ability to copy and adjust formulas is one of the most powerful tools in Excel’s impressive armory.

1 Open First Quarter Sales and Profit 9 from your sample files folder (If it isn’t already open).

2 Consider the formula in cell B9.

Click onto cell B9 and view the formula displayed in the formula bar (the formula bar is at the top right of the screen grab below).

The formula is =SUM(B4:B8). AutoSum created it for us in: Lesson 2-3: Use AutoSum to quickly calculate totals. The formula uses the SUM() function to add together the values in the range B4:B8.

Think about the formula that would work in cell C9 (the total sales for February). It would be: =SUM(C4:C8). Similarly the formula that would work in cell D9 (the total sales for March) would be =SUM(D4:D8).

As we move to the right all that is needed is to increment the letter for each cell reference in the formula and we’ll get the right answer every time.

Now AutoFill is very clever and realizes this. When we AutoFill a cell containing a formula to the right, AutoFill increments the letters in each cell reference.

Most of the time that is exactly what we want.

Later, in Lesson 3-12: Understand absolute and relative cell references, we’ll learn how to fine-tune the way in which AutoFill adjusts cell references. This will allow you to implement some more advanced AutoFill techniques.

3 AutoFill cell B9 to the right as far as cell D9.
You may see a row of hashes in Cell C9. This is because the value is too wide to fit in the cell. If this is the case, AutoFit the column using the skills learned in: Lesson 2-9: Re-size rows and columns.

The correct answers for Feb and Mar sales are shown on the worksheet. Click on the Feb total cell (C9) and look at the formula in the formula bar.

You can see that AutoFit has done its work perfectly, creating a sum of the values in cells C4:C8. Our five branches have sold exactly the same amount in both January and February, but a little less in March.

4 Consider the formula in cell E4.

Click onto cell E4 and view the formula displayed in the formula bar.

The formula is =AVERAGE(B4:D4). AutoSum created it for us in: Lesson 2-11: Use AutoSum to quickly calculate averages.

Think about the formula that would work in cell E5 (the average sales for Los Angeles). It would be: =Average(B5:D5). Similarly the formula that would work in cell E6 (the total sales for London) would be =Average(B6:D6).

As we move downward all that is needed is to increment the number for each cell reference in the formula. This is exactly what AutoFill will do.

5 AutoFill cell E4 down to E8 to see the Average sales for each branch.

6 AutoFill cell F4 down to F8 to view the maximum sales for each branch.

7 Save your work as First Quarter Sales and Profit-10.
Lesson 2-16: Use AutoFill options

Sometimes AutoFill begins to misbehave and actually gets in the way of efficient work by wrongly anticipating what you need.

1. Open *First Quarter Sales and Profit* from your sample files folder (if it isn’t already open).
2. In cell F18 type the date 1-Jan-09.
3. AutoFill down as far as cell F24.

   The cells are populated with sequential dates:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Monday</td>
<td>19</td>
<td>20 Wednesday</td>
<td>21 Thursday</td>
<td>22 Friday</td>
</tr>
<tr>
<td>19</td>
<td>Tuesday</td>
<td>20</td>
<td>02-Jan-08</td>
<td>03-Jan-08</td>
<td>04-Jan-08</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>21</td>
<td>03-Jan-08</td>
<td>04-Jan-08</td>
<td>05-Jan-08</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>22</td>
<td>04-Jan-08</td>
<td>05-Jan-08</td>
<td>06-Jan-08</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>23</td>
<td>05-Jan-08</td>
<td>06-Jan-08</td>
<td>07-Jan-08</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>24</td>
<td>06-Jan-08</td>
<td>07-Jan-08</td>
<td>07-Jan-09</td>
</tr>
</tbody>
</table>

4. In cell G18 type the date 31-Mar-2009.
5. AutoFill down as far as cell G24.

   At some time you’ll need to add transaction dates to a worksheet and will have four or five entries with the same date.
   AutoFill is perfect for eliminating the need to re-type the date for each transaction, but its insistence upon incrementing the date every time could be very frustrating.
   Fortunately we can change the default behavior.

6. Click the Auto Fill Options Smart Tag at the bottom right corner of the filled cells.
7 Click **Copy Cells** to tell AutoFill not to increment the date.

The purpose of the **Fill Formatting** options will be clear later in the course when you have completed: **Session Four: Making Your Worksheets Look Professional**.

Here’s what the other options will do:

<table>
<thead>
<tr>
<th>Copy Cells</th>
<th>Fill Series</th>
<th>Fill Days</th>
<th>Fill Weekdays</th>
<th>Fill Months</th>
<th>Fill Years</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is what we just did. The first cell is copied to the other cells.</td>
<td>The default for dates that include the day. The date increments by one day at a time.</td>
<td>The date increments by one day at a time.</td>
<td>Because 3rd April 2009 is a Friday the weekend days are omitted and the series jumps from 3rd April to 6th April.</td>
<td>Normally this would show the same day number for each month. In this example, there are only 30 days in two of the months so 30th is shown instead of 31st.</td>
<td>The same calendar day is shown for each subsequent year.</td>
</tr>
</tbody>
</table>

8 Access fill options using right-click AutoFill.

1. Click on cell F18 to make it the active cell.
2. AutoFill down to cell F24, but this time, hold down the right mouse button.

   When you release the mouse button you are presented with the AutoFill options (see sidebar).

   This method is preferred to the Smart Tag method because it is faster (one click instead of two)!

9 Change back to Fill Series or Fill Days.

In this example **Fill Series** and **Fill Days** produce exactly the same result.

10 Save your work as **First Quarter Sales and Profit-11**.
Lesson 2-17: Speed up your AutoFills and create a custom fill series

In this lesson we’re going to learn some advanced AutoFill techniques that will massively speed up your efficient use of the AutoFill feature.

1. Open *First Quarter Sales and Profit-11* (if it isn’t already open).
2. Delete the contents of cells G18:G24.
3. Type **31-Mar-09** into cell G18.

   This is a real master tip!
   Hover over the AutoFill handle (the black spot at the bottom right hand corner of cell G18). When you are sure that you have the correct black cross cursor shape, double click to automatically fill down.

5. Use AutoFill to copy a cell value.
   1. Delete all of the dates from cells G19:G24 leaving only the date 31-Mar-09 in cell G18.
   2. Click in cell G18 to make it the active cell.
   3. Hold down the `<Ctrl>` key and AutoFill cell G18 down as far as cell G24 by dragging the AutoFill handle down with the mouse.
   4. Release the mouse button.

   Because you held the `<Ctrl>` key down simply copied the cell instead of creating a series of values.
6 Create a custom list.

1. Click File→Options→Advanced.
2. Scroll down to the General category and click the gray Edit Custom Lists... button.

The Custom Lists dialog appears.

3. Click in the List entries window and add four custom list entries: North, South, East and West.

4. Click the OK button and OK again to close the dialogs.

7 Use a custom list.

Type North in any cell and AutoFill down.

As you AutoFill the custom list entries appear in the worksheet (see sidebar).

8 Delete the North, South, East, West... cells from the worksheet.

9 Save your work as First Quarter Sales and Profit-12.
Lesson 2-18: Use the zoom control

Zooming is used to magnify or reduce the worksheet. If you have a lot of rows in a worksheet and have good eyes you might want to zoom out sometimes to see more of the worksheet on one screen.

1. Open First Quarter Sales and Profit-12 from your sample files folder (if it isn’t already open).

2. Zoom in and out of a worksheet using the mouse wheel.
   
   The fastest way to zoom a worksheet is by using the mouse. Most mice these days have a wheel in the middle of the buttons. To zoom using this wheel hold down the <Ctrl> key on the keyboard and roll the wheel to zoom in and out.

3. Zoom in and out of a worksheet using the zoom control.
   
   The zoom control is at the bottom right of your screen, Click and drag on the zoom control slider to zoom in and out of your worksheet. You can also zoom by clicking the plus and minus buttons on either side of the Zoom control.


We’re going to use the Zoom dialog to make this selection completely fill the screen.
5 Double-click the left hand side of the zoom bar. The Zoom dialog is displayed.

6 Select the Fit Selection option button and click the OK button.

The worksheet is zoomed so that the selected cells completely fill the screen.

7 Zoom back to 100% using the Ribbon.

You’ll probably find the zoom bar to be the quickest and most convenient way to zoom, but the View Ribbon also has a Zoom group containing three buttons:

Use the 100% button to restore the screen to normal.
Lesson 2-19: Print out a worksheet

We aren’t going to explore every option for preparing and printing a worksheet in this lesson. Printing is such a huge subject that we devote a whole session to it in: Session Seven: Printing Your Work.

This lesson only aims to teach you the bare minimum skills you need to put your work onto paper.

1. Open First Quarter Sales and Profit-12 from your sample files folder (if it isn’t already open).

   ![First Quarter Sales and Profit-12](image)

2. Click File ➔ Print.

   *Backstage View* appears offering many preview and print options:
3. Click on the zoom button to see the zoom feature working. Each time you click on the button the page zooms in and out.

4. Print the worksheet.
   Click the Print button:
   ![Print button]

   The page is printed on the selected printer.
Session 2: Exercise

1. Open a new blank workbook.
2. Use AutoFill to put the three months Jan, Feb, and Mar into cells A4:A6.
3. Using only the keyboard add the following data:

   ![Spreadsheet Image]

   - Use AutoSum to compute London’s total profit for Jan/Feb/Mar in cell B7.
   - Use AutoSum to compute the average January profit in cell E4.
   - Use AutoFill to extend the London total in cell B7, to the Paris and New York totals in cells C7 and D7.
   - Use AutoFill to extend the January average profit in cell E4, to the February and March average profits in cells E5 and E6.
   - Select all of Column A and all of Column E (at the same time) and bold face the values in them.
   - Select row 3 and row 7 (at the same time) and bold face the values in them.

   ![Spreadsheet Image]

   - Select cells B4:B6 and cells D4:D6 at the same time and then read the total London and New York sales figure for Jan, Feb and March from the summary information displayed on the status bar.
   - Select cells B4:D6 and zoom the selection so that these cells fill the screen.
   - Save your work as Exercise2-End.
Session 2: Exercise answers

These are the four questions that students find the most difficult to remember:

<table>
<thead>
<tr>
<th>Q 10</th>
<th>Q 8</th>
<th>Q 4 and 5</th>
<th>Q 2</th>
</tr>
</thead>
</table>
| 1. Hover over the center of cell B4 so that you see the white cross cursor shape.  
2. Click and drag down to cell B6.  
3. Hold down the <Ctrl> key.  
4. Hover over cell D4 until you see the white cross cursor shape.  
5. Click and drag down to cell D6.  
This was covered in: Lesson 2-7: Select non-contiguous cell ranges and view summary information. | 1. Click on the column A header.  
2. Hold down the <Ctrl> key.  
3. Click on the column E header.  
4. Click Home→Font→Bold.  
This was covered in: Lesson 2-6: Select adjacent and non-adjacent rows and columns. | 1. Click in cell B7.  
2. Click Home→Editing→AutoSum (Q4).  
OR  
Click Home→Editing→AutoSum→Average (Q5).  
3. Either press the <Enter> key or click the AutoSum button again.  
This was covered in: Lesson 2-3: Use AutoSum to quickly calculate totals. | 1. Type Jan into cell A4 and press the <Enter> key.  
2. Click cell A4 once to make it the active cell.  
3. Hover the mouse cursor over the bottom right corner of the cell until you see the black cross cursor shape.  
4. Click and drag down to cell A6.  
This was covered in: Lesson 2-14: Use AutoFill for text and numeric series. |

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1. Refer to: Lesson 2-2: Create a new workbook and view two workbooks at the same time.
2. Refer to: Lesson 2-1: Enter text and numbers into a worksheet.
3. Refer to: Lesson 2-15: Use AutoFill to adjust formulas.
4. Refer to: Lesson 2-15: Use AutoFill to adjust formulas.
5. Refer to: Lesson 2-6: Select adjacent and non-adjacent rows and columns.
6. Refer to: Lesson 2-18: Use the zoom control.
7. Refer to: Lesson 1-5: Save a workbook.